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Foreword for Stellarium 25.1

Almost twenty-�ve years have elapsed since Fabien ChØreau typed the �rst lines of code of a
desktop planetarium which should be based on modern algorithms from computer graphics to
provide a trustworthy simulation of the night sky, utilizing OpenGL real-time graphics technology
which best runs on dedicated graphics hardware. The beautiful program that evolved since then
has been downloaded millions of times to run on desktop computers and notebooks all around
the planet, on various operating systems and in dozens of languages. The �rst team of developers
also developed ways to control Goto telescopes which became a popular feature. In the years to
come this was occasionally extended by further external contributors to provide support for INDI
and RTS2 on Linux and ASCOM on Windows, but keeping the systems working by occasionally
upgrading the protocols was left to the maintainers who may be limited in their access to instruments
or just have not even enough time to go observing themselves.

Only in late 2022 we were con�dent enough in the accuracy of our implementations of planetary
algorithms and various coordinate re�nements that we have �nally dropped the zero version number
and released version 1.0, and started using the year number as basis for later versions. On this
occasion we also moved forward to upgrading the foundational Qt GUI framework from Qt5 to
Qt6 to be prepared for upgrades in the next years. To keep compatibility with older PCs, we
kept providing builds based on the aging Qt5 framework. However it turned out that the new Qt6
framework and the widely used telescope control framework ASCOM 6 apparently don’t play
nicely together. We saw several reports about crashes coming in, but were not able to really solve
the issue, requiring us to �nally disable support on Qt6-based builds. The builds on the older Qt5
framework seemed to always work nicely.

With only three core developers working part-time at best and otherwise busy in other projects
or daytime jobs, we cannot do giant leaps, but the program has evolved nicely in other areas like
the AstroCalc dialog that becomes richer in every version.

While many improvements had involved re�nements for planetary positions and modelling of
observing conditions, other users were more interested in star positions over millennia. The star
catalog we have used since 2006, which was based on the then best positional measurements made
by ESA’s Hipparcos satellite, was discovered to have a systematic error that caused slightly wrong



coordinates millennia from the present. Also, binary stars could be observed to �y apart, because
their motions around each other were not modelled.

Just a few weeks before release 24.4 a new developer, Henry Leung, showed up and offered
a new star catalog for Stellarium. We needed a few weeks to test, check for inconsistencies and
�nding how to best link this to our existing infrastructure, but days after 24.4 was out, we fully
embraced this new catalog, now a combination of ESA’s latest and best astrometry satellite Gaia’s
DR3 catalog with � still � the Hipparcos data, required for the brightest stars which were too
bright for Gaia to measure. Computers have become more powerful since 2006, and so this new
catalog comes with new features: While previously we just showed numerical data for parallax,
now you can observe the stars’ actual parallaxes as you move around the Sun! If needed in
demonstrations, you can exaggerate the effect. Proper motions are now modelled accurately, and
even stars’ distances change, so you can observe the brightness change of close stars like Barnard’s
as they pass our Solar system. And, what some may like best, binary stars with known orbits move
around each other while doing all this. So, fasten your seat belts and observe, for example, the
fast spatial motion of 61 Cygni, affected by annual parallax and aberration, and observe the two
components dancing around each other over centuries! Add a HiPS survey displayed behind the
stars, and see when the actual plates were taken so that the fast running stars fall in place. Observe
the combination of motions and you will get a higher appreciation for how dif�cult �nding stellar
distances from positional measurements actually must have been for the pioneers in the �eld in the
19th century. Each star is now identi�ed by its catalog number in Gaia DR3 as an added bene�t.

If you need to run an older version of Stellarium and have downloaded the higher-level star
catalogs, these will still be available for running these older versions, but you will want to download
the new star catalogs as soon as possible.

We had actually planned for a different large development to begin in early 2025. Fabien’s
newer projects, Stellarium-web and Stellarium-mobile, are utilizing a more modern data format for
their skyculture descriptions: JSON. Also in our core team, we were convinced that the �le formats
used so far are not �exible enough to model the many aspects of the rich astronomical heritage
of cultures found all over the world, and we had already collected ideas for years. In a scienti�c
symposium in Jena in late 2023 that was also supported by Stellarium’s donation fund we were able
to work out a few de�nitions and requirements of how Stellarium can help scientists collecting,
displaying and communicating all this. Starting with this version 25.1, we are therefore using a
completely new �le format for the sky cultures which should be compatible with all programs
of the Stellarium family. Ruslan, who also optimizes the OpenGL rendering in countless little
improvements, did a great job converting all existing data, especially the translation into dozens
of existing languages, so that hopefully no vocabulary that was already translated was lost. See
chapter 9 for details about the new features as we use them now, and expect more features to come
in this area as we continue to work during this year.

Coming back to ASCOM, while testing with version 7 we could not trigger the bad crash that
was reported before, therefore we hope that re-enabling ASCOM in this release will work for our
users with actual instruments. Your feedback is important to �nd this out, and if you are familiar
with programming, we can need support in this part of the program.

We want to thank all sponsors and backers of the project as meanwhile we have collected
substantial funds to support development also in work hours. We like working on this project, but
also must pay the bills, so please keep up your kind support!

Work on other things has started, but they are scheduled for completion only in upcoming
versions. So, Stellarium is going strong as we approach the 25th anniversary of this project!

In the name of all prior and current developers we wish you much enjoyment with this and
future versions of the Stellarium desktop planetarium!

Georg Zotti and Alexander Wolf, March 2025
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1. Introduction

Stellarium is a software project that allows people to use their home computer as a virtual plan-
etarium. It calculates the positions of the Sun and Moon, planets and stars, and draws how the
sky would look to an observer depending on their location and the time. It can also draw the
constellations and simulate astronomical phenomena such as meteor showers or comets, and solar
or lunar eclipses.

Stellarium may be used as an educational tool for teaching about the night sky, as an ob-
servational aid for amateur astronomers wishing to plan a night’s observing or even drive their
telescopes to observing targets, or simply as a curiosity (it’s fun!). Because of the high quality
of the graphics that Stellarium produces, it is used in some real planetarium projector products
and museum projection setups. Some amateur astronomy groups use it to create sky maps for
describing regions of the sky in articles for newsletters and magazines, and the exchangeable sky
cultures feature invites its use in the �eld of Cultural Astronomy research and outreach.

Stellarium is under continuous development, and by the time you read this guide, a newer
version may have been released with even more features than those documented here. Check for
updates to Stellarium at the Stellarium website1.

If you have questions and/or comments about this guide, or about Stellarium itself, visit the
Stellarium site at GitHub2 or our Google Groups forum3.

1.1 Historical notes

Fabien ChØreau started the project during the summer 2000, and throughout the years found
continuous support by a small team of enthusiastic developers.

Here is a list of past and present major contributors sorted roughly by date of arrival on the
project:

1https://stellarium.org
2https://github.com/Stellarium/stellarium
3https://groups.google.com/forum/#!forum/stellarium

https://stellarium.org
https://github.com/Stellarium/stellarium
https://groups.google.com/forum/#!forum/stellarium


4 Chapter 1. Introduction

Fabien ChØreau original creator, maintainer, general development
Matthew Gates maintainer, original user guide, user support, general development
Johannes Gajdosik astronomical computations, large star catalogs support
Johan Meuris GUI design, website creation, drawings of our 88 Western constellations
Nigel Kerr Mac OSX port
Rob Spearman funding for planetarium support
Barry Gerdes user support, tester, Windows support. Barry passed away in October 2014 at age

80. He was a major contributor on the forums, wiki pages and mailing list where his good
will and enthusiasm is strongly missed. RIP Barry.

Timothy Reaves ocular plugin
Bogdan Marinov GUI, telescope control, other plugins
Diego Marcos SVMT plugin
Guillaume ChØreau display, optimization, Qt upgrades, HiPS surveys
Alexander Wolf maintainer, DSO catalogs, AstroCalc module, user guide, general development
Georg Zotti astronomical computations, Scenery 3D plugin, ArchaeoLines and Calendars plugins,

general development, user guide, user support
Marcos Cardinot MeteorShowers plugin
Florian Schaukowitsch Scenery 3D plugin, Remote Control plugin, RemoteSync plugin, OBJ

rendering, Qt/OpenGL internals
Teresa Huertas RoldÆn Planetary nomenclature
Jocelyn Girod Observing Lists
Ruslan Kabatsayev ShowMySky Skylight model (based on Bruneton’s model)
Worachate Boonplod Eclipse computations

Unfortunately time is evolving, and most members of the original development team are no
longer able to devote most of their spare time to the project (some are still available for limited
work which requires speci�c knowledge about the project).

As of 2017, the project’s maintainer is Alexander Wolf, doing most maintenance and regular
releases. He has also introduced the AstroCalc module. Other new features are contributed mostly
by Georg Zotti and his team focusing on extensions of Stellarium’s applicability in the �elds of
historical and cultural astronomy research (which means Stellarium is getting more accurate) and
outreach (making it usable for museum installations), but also on graphic items like comet tails,
light pollution artwork or the Zodiacal Light.

A detailed track of development can be found in the ChangeLog �le in the installation folder. A
few important milestones for the project:
2000 �rst lines of code for the project
2001-06 �rst public mention (and user feedbacks!) of the software on the French newsgroup

fr.sci.astronomie.amateur 4

2003-01 Stellarium reviewed by Astronomy magazine
2003-07 funding for developing planetarium features (�sheye projection and other features)
2005-12 use accurate (and fast) planetary model
2006-05 Stellarium �Project Of the Month� on SourceForge
2006-08 large stars catalogs
2007-01 funding by ESO for development of professional astronomy extensions (VirGO)
2007-04 developers’ meeting near Munich, Germany
2007-05 switch to the Qt4 library as main GUI and general purpose library
2009-09 plugin system, enabling a lot of new development

4https://groups.google.com/d/topic/fr.sci.astronomie.amateur/OT7K8yogRlI/disc

ussion

https://groups.google.com/d/topic/fr.sci.astronomie.amateur/OT7K8yogRlI/discussion
https://groups.google.com/d/topic/fr.sci.astronomie.amateur/OT7K8yogRlI/discussion
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2010-07 Stellarium ported on Maemo mobile device
2010-11 arti�cial satellites plugin
2014-06 high quality satellites and Saturn rings shadows, normal mapping for moon craters
2014-07 v0.13.0: adapt to OpenGL evolutions in the Qt5 framework, now requires more modern

graphic hardware than earlier versions
2015-04 v0.13.3: Scenery 3D plugin
2015-10 v0.14.0: Accurate precession
2016-07 v0.15.0: Remote Control plugin
2016-12 v0.15.1: DE430&DE431, AstroCalc, DSS layer, and Stellarium acting as SpoutSender
2017-06 v0.16.0: Remote Sync plugin, polygonal OBJ models for minor bodies, RTS2 telescope

support
2017-09 v0.16.1: Standard and extended DSO catalog, new subcatalogues for DSO
2017-12 v0.17.0: Nomenclature labels for planets and moons, INDI telescope support
2018-03 v0.18.0: Multiple image surveys
2019-12 v0.19.3: ASCOM telescope support
2020-09 v0.20.3: Accurate seasons’ beginnings
2021-03 v0.21.0: Accurate planet rotation (Libration, central meridians, subsolar points, . . . )
2021-09 v0.21.2: Annual aberration, DE440&441. Accuracy goals reached.
2022-10 Stellarium 1.0: Switch to Qt6, ShowMySky skylight model, Eclipse details.
2025-03 v25.1: New star catalog, parallax and revolving binary stars, new Skyculture �le format.

1.2 Version Numbers

Since its inception, Stellarium’s version number had started with 0 to indicate �work in progress�.
The numbers after that have followed a year.release convention with approximately seasonal
releases since 2018. (For example, 0.18.2 was the third release in 2018 which appeared around
autumn equinox, after 0.18.0 and 0.18.1.) If needed urgently, there can be additional releases which
however break the simple season count.

A software version number of 1.0 signi�es a milestone of some sort, like completion of a
particular original feature set, usability, or stability. With the completion of the original accuracy
issues in 2021 we felt it was time to �nally change version number to 1. However, a major technical
update in the underlying Qt framework also forced some technical changes upon us to ensure
Stellarium will remain working in the later 2020s, and therefore we decided to base the 1.* series
on the new version of Qt.

Qt6 does not support old hardware, particularly 32-bit systems will not be able to run 1.*
versions. Therefore, we are going to keep both series alive for those with older hardware. Thanks to
only minor differences in the underlying frameworks, both series should retain feature equivalence.
The only notable difference for now lied in the Scripting functionality (see chapter 17). Our
�internal� version numbers therefore indicated which version of Qt was used: series 0.* continued
to be based on Qt5, and series 1.* was based on Qt6.

In 2023 we’ve changed the numbering scheme again to avoid new misunderstandings. Our
�internal� version has a standard of 3 components5, where the �rst indicates the two last digits of the
year of release, the second is the release within that year (0 is used before �rst release, from January
to March) and the last one can be 0 for releases, or the day number of the current year for snapshots.
Our short (�public�) version has 2 components: year and number of the release. Example: the �rst
release in year 2023 has version 23.1.0 and short (public) version 23.1, the series has number 23.0.

In addition to the version number we are adding the name component qtX, where X is 5 or 6

respectively and marks the major version of Qt which is used as the base for the package.

5On Windows it has 4 components, where the last one is always 0.
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1.3 Acknowledgements

Stellarium has been kindly supported by ESA in their Summer of Code in Space initiatives, which
so far has resulted in better planetary rendering (2012), the Meteor Showers plugin (2013), the web-
based remote control and an alternative solution for planetary positions based on the DE430/DE431
ephemeris (2015), the RemoteSync plugin and OBJ models (2016), and the planet nomenclature
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Institute for Archaeological Prospection and Virtual Archaeology, Vienna, Austria.

Stellarium receives funding on OpenCollective. We thank all our sponsors and backers who
help us maintaining the software and expanding it with yet more features to come.

1.4 Scienti�c use

Stellarium has gained wide popularity in the research areas of cultural astronomy. Please note
limitations of Stellarium mentioned in Appendix F. If you used Stellarium in scienti�c work, please
cite our overview paper (Zotti, S. Hoffmann, et al., 2021) or those mentioned in the respective
feature descriptions.

1.5 About this User Guide

This guide is based on the user guide written by Matthew Gates for version 0.10 around 2008.
The guide was then ported to the Stellarium wiki and continuously updated by Barry Gerdes
and Alexander Wolf up to version 0.12. Unfortunately, some new features were not properly
documented in the wiki, and generally, without Barry the wiki started to fall out of sync with the
actual program. In late 2015 we (Alexander and Georg) started porting the texts back to LATEX and
updated and added information where necessary, or wrote new chapters for the features which were
introduced in the last years. We feel that a single book is the better format for of�ine reading. The
PDF version of this guide has a clickable table of contents and clickable hyperlinks.

These new editions of the Guide (since v0.15) do not contain notes about using earlier versions
than 0.13 or using very outdated hardware. Some references to previous versions may still be made
for completeness, but if you are using earlier versions of Stellarium for particular reasons, please
use the older guides.



2. Getting Started

2.1 System Requirements

Stellarium has been seen to run on most systems where Qt5 is available, from tiny ARM computers
like the Raspberry Pi 2/3/4 or Odroid C1 to big museum installations with multiple projectors and
planetaria with �sh-eye projectors. The most important hardware requirement is a contemporary
graphics subsystem.

2.1.1 Minimum

� Linux/Unix; Windows 7 and later; macOS 10.15 and later1

� 3D graphics capabilities which support OpenGL 3.0 (2008 GeForce 8xxx and later, ATI/AMD
Radeon HD-2xxx and later; Intel HD graphics (Core-i 2xxx and later)) or OpenGL ES 2.0
(e.g., ARM SBCs like Raspberry Pi 2/3/4). On Windows, some older cards may be supported
via ANGLE when they support DirectX9.

� Screen resolution 1024 �7682

� 512 MB RAM
� 250 MB free on disk
� Keyboard

2.1.2 Recommended

� Linux/Unix; Windows 10 and later; macOS 11.0 and later

1Windows 10 and macOS 11.0 is minimal for Qt6-based Stellarium.
2On Linux, an 800 � 600 screen can still be used by scaling the desktop e.g. to 1200� 900:

xrandr --output HDMI -1 --scale 1.5 x1.5

To reset after running Stellarium, run

xrandr --output HDMI -1 --scale 1x1
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� 3D graphics card which supports OpenGL 3.3 or higher
� FullHD (1920�1080 or 1920�1200) or larger screen.3

� 1 GB RAM or more
� 1.5 GB free on disk (About 3GB extra required for the optional DE430/DE431 �les).
� Keyboard and mouse or equivalent device (e.g. touchpad)
� A dark room for realistic rendering � details like the Milky Way, Zodiacal Light or star

twinkling can’t be seen in a bright room.

2.2 Downloading

Download the correct package for your operating system directly from the main page,
https://stellarium.org. An archive of all available versions is available at our GitHub page �
https://github.com/Stellarium/stellarium/releases.

2.3 Installation

2.3.1 Windows

1. Double click on the installer �le you downloaded:
� stellarium-25.1-win64.exe for 64-bit Windows 7 and later.
� stellarium-25.1-win32.exe for 32-bit Windows 7 and later.

2. Follow the on-screen instructions.

Unattended Install/Uninstall

The installation program allows for unattended installation (e.g., for lab setups) following of�cial
documentation4.

You can uninstall the program like any other program from the Applications list in the system
control panel. The uninstaller asks if you want to remove (delete) all your Stellarium user data. Be
sure to answer NO when you plan to re-use landscapes, 3D sceneries and the like. For unattended
uninstallation in larger setups, also the uninstaller can be called with additional options, which will
keep the user data.

"C:\ Program Files [ (x86 )]\ Stellarium \ unins000 .exe" / VERYSILENT / SUPPRESSMSGBOXES

2.3.2 macOS

1. Locate the downloaded Stellarium �le in Finder (Stellarium will be automatic unpack
from archive by operating system after downloading).

2. Drag Stellarium to the Applications folder.

2.3.3 Linux

Check if your distribution has a package for Stellarium already � if so you’re probably best off
using it. If not, you can download and build the source.

For Ubuntu Linux we provide a package repository with the latest stable releases. Open a
terminal and type:

sudo add -apt - repository ppa: stellarium /stellarium - releases

sudo apt -get update

sudo apt -get install stellarium

3HiDPI screens may work, but show occasional platform-dependent issues.
4https://documentation.help/Inno-Setup/topic_setupcmdline.htm

https://stellarium.org
https://github.com/Stellarium/stellarium/releases
https://documentation.help/Inno-Setup/topic_setupcmdline.htm
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You can also download and run universal binary packages for linux systems: �at5 or snap6.

Raspberry Pi 2/3/4

These tiny ARM-based computers are very popular for small and energy-ef�cient applications
like controlling push-to Dobsonians. Stellarium requires Mesa 17 or later, available in the current
Raspbian OS. To set up a Raspberry Pi 2 or 3 with Raspbian Buster for use with Stellarium, activate
the OpenGL driver in raspi-con�g. The latest Raspberry Pi 4 comes with this driver by default
and can even drive two HiDPI screens.

You must build Stellarium from sources. Please follow instructions from the wiki7.
For Ubuntu 16.04 LTS, follow instructions8.
Note that as of December 2019 the 3D planets do not work on Raspberry Pi 2/3, and DSS or

HiPS surveys seem to cause issues after a while.

2.4 Running Stellarium

2.4.1 Windows

The Stellarium installer creates a whole list of items in the Start Menu under the Programs/Stel-

larium section. The list evolves over time, not all entries listed here may be installed on your
system. Select one of these to run Stellarium:
Stellarium OpenGL version. This is the most ef�cient for modern PCs and should be used

when you have installed appropriate OpenGL drivers. Note that some graphics cards are
�blacklisted� by Qt to immediately run via ANGLE (Direct3D), you cannot force OpenGL in
this case. This should not bother you.

Stellarium (ANGLE mode) Uses Direct3D translation of the OpenGL rendering via ANGLE
library. Forces Direct3D version 9.9

Stellarium (ANGLE WARP mode) Uses DirectX3D 11 software rendering via ANGLE library.
This should work on any PC without dedicated graphics card.9

Stellarium (MESA mode) Uses software rendering via MESA library. This should work on any
PC without dedicated graphics card.

Stellarium (200%) On some systems with 4k screens, Stellarium appears too small. This link
forces an upscaling.
If for some reason Stellarium’s dialogs and buttons appear too large, and you want to scale
them down, edit the link and change the scaling parameter.

On startup, a diagnostic check is performed to test whether the graphics hardware is capable of
running. If all is �ne, you will see nothing of it. Else you may see an error panel informing you
that your computer is not capable of running Stellarium (�No OpenGL 2 found�), or a warning
that there is only OpenGL 2.1 support. The latter means you will be able to see some graphics,
but depending on the type of issue you will have some bad graphics. For example, on an Intel
GMA4500 there is only a minor issue in Night Mode, while on other systems we had reports of
missing planets or even crashes as soon as a planet comes into view. If you see this, try running in
Direct3D 9 or MESA mode, or upgrade your system. The warning, once ignored, will not show
again.

When you have found a mode that works on your system, you can delete the other links.

5https://flathub.org/apps/details/org.stellarium.Stellarium
6https://snapcraft.io/stellarium-daily
7https://github.com/Stellarium/stellarium/wiki/Raspberry-Pi
8https://ubuntu-mate.community/t/tutorial-activate-opengl-driver-for-ubuntu-m

ate-16-04/7094
9Stellarium series 0.* and Qt5-based builds only

https://flathub.org/apps/details/org.stellarium.Stellarium
https://snapcraft.io/stellarium-daily
https://github.com/Stellarium/stellarium/wiki/Raspberry-Pi
https://ubuntu-mate.community/t/tutorial-activate-opengl-driver-for-ubuntu-mate-16-04/7094
https://ubuntu-mate.community/t/tutorial-activate-opengl-driver-for-ubuntu-mate-16-04/7094
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2.4.2 macOS

Double click on the Stellarium application. Add it to your Dock for quick access.

2.4.3 Linux

If your distribution had a package you’ll probably already have an item in the GNOME or KDE
application menus. If not, just open a terminal and type stellarium.

2.5 Troubleshooting

Stellarium writes startup and other diagnostic messages into a log�le. Please see section 5.3 where
this �le is located on your system. This �le is essential in case when you feel you need to report a
problem with your system which has not been found before.

At startup also a few pop-up windows may appear with information about possible troubles or
warnings to make those messages more visible for users.

On some Intel UHD systems users may see the screen blanking when Stellarium is working
� the startup of the program with --single-buffer parameter can help here. The same option also
helps when on an Nvidia system tooltips don’t appear in fullscreen mode.

On some older or weak systems, the option --low-graphics may be required. This forcefully
disables advanced graphics features of OpenGL 3.3 which otherwise would slow down or cause
other issues on such systems.

If you don’t succeed in running Stellarium, please see the online forum10. It includes FAQ
(Frequently Asked Questions, also Frequently Answered Questions) and a general question section
which may include further hints. Please make sure you have read and understood the FAQ before
asking the same questions again.

10https://github.com/Stellarium/stellarium

https://github.com/Stellarium/stellarium


3. A First Tour

Figure 3.1: Stellarium main view. (Combination of day and night views.)

When Stellarium �rst starts, we see a green meadow under a sky. Depending on the time of day, it
is either a day or night scene. If you are connected to the Internet, an automatic lookup will attempt
to detect your approximate position.1

1See section 4.2 if you want to switch this off.
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At the bottom left of the screen, you can see the status bar. This shows the current observer
location, vertical �eld of view (FOV), graphics performance in frames per second (FPS) and the
current simulation date and time. If you move the mouse over the status bar, it will move up to
reveal a tool bar which gives quick control over the program.

The rest of the view is devoted to rendering a realistic scene including a panoramic landscape
and the sky. If the simulation time and observer location are such that it is night time, you will see
stars, planets and the moon in the sky, all in the correct positions.

You can drag with the mouse on the sky to look around or use the cursor keys. You can zoom
with the mouse wheel or the Page or Page keys.

Much of Stellarium can be controlled very intuitively with the mouse. Many settings can
additionally be switched with shortcut keys (hotkeys). Advanced users will learn to use these
shortcut keys. Sometimes a key combination will be used. For example, you can quit Stellarium by
pressing Ctrl + Q on Windows and Linux, and + Q on Mac OS X. For simplicity, we will
show only the Windows/Linux version. We will present the default hotkeys in this guide. However,
almost all hotkeys can be recon�gured to match your taste. Note that some listed shortkeys are only
available as key combinations on international keyboard layouts, e.g., keys which require pressing
AltGr on a German keyboard. These must be recon�gured, please see 4.8 for details.

The way Stellarium is shown on the screen is primarily governed by the menus. These are
accessed by dragging the mouse to the left or bottom edge of the screen, where the menus will slide
out. In case you want to see the menu bars permanently, you can press the small buttons right in the
lower left corner to keep them visible.

3.1 Time Travel

When Stellarium starts up, it sets its clock to the same time and date as the system clock. However,
Stellarium’s clock is not �xed to the same time and date as the system clock, or indeed to the
same speed. We may tell Stellarium to change how fast time should pass, and even make time
go backwards! So the �rst thing we shall do is to travel into the future! Let’s take a look at the
time control buttons on the right hand ride of the tool-bar. If you hover the mouse cursor over the
buttons, a short description of the button’s purpose and keyboard shortcut will appear.

Button Shortcut key Description

J Decrease the rate at which time passes

K Make time pass as normal

L Increase the rate at which time passes

8 Return to the current time & date

Table 3.1: Time Travel

OK, so lets go see the future! Click the mouse once on the increase time speed button .
Not a whole lot seems to happen. However, take a look at the clock in the status bar. You should
see the time going by faster than a normal clock! Click the button a second time. Now the time is
going by faster than before. If it’s night time, you might also notice that the stars have started to
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move slightly across the sky. If it’s daytime you might be able to see the sun moving (but it’s less
apparent than the movement of the stars). Increase the rate at which time passes again by clicking
on the button a third time. Now time is really �ying!

Let time move on at this fast speed for a little while. Notice how the stars move across the sky.
If you wait a little while, you’ll see the Sun rising and setting. It’s a bit like a time-lapse movie.

Stellarium not only allows for moving forward through time � you can go backwards too! Click

on the real time speed button . The stars and/or the Sun should stop scooting across the sky.

Now press the decrease time speed button once. Look at the clock. Time has stopped. Click
the decrease time speed button four or �ve more times. Now we’re falling back through time at
quite a rate (about one day every ten seconds!).

Time Dragging, Time Scrolling

Another way to quickly change time is time dragging. Press Ctrl , press the left mouse button, and
slide the mouse along the direction of daily motion to go forward, or to the other direction to go
backward.

Similarly, pressing Ctrl and scrolling the mouse wheel will advance time by minutes, pressing
Ctrl + and scrolling the mouse wheel will advance time by hours, Ctrl + Alt by days, and �nally
Ctrl + + Alt by calendar years.

Enough time travel for now. Wait until it’s night time, and then click the real time speed button

. If all works as intended you will now be looking at the night sky.

3.2 Moving Around the Sky

Key Description

Cursor keys Pan the view left, right, up and down
Page / Page , Ctrl + / Ctrl + Zoom in and out
Left mouse button Select an object in the sky
Right mouse button, Ctrl + Clear selected object
Centre mouse button (wheel press) Centre selected object and start tracking
Mouse wheel Zoom in and out

Centre view on selected object
Forward-slash ( / ) Auto-zoom in to selected object
Backslash ( \ ) Auto-zoom out to original �eld of view

+ N Look towards North (keep altitude)
+ E Look towards East (keep altitude)
+ S Look towards South (keep altitude)
+ W Look towards West (keep altitude)
+ Z Look towards Zenith (south down)

Alt + + N Look towards North Celestial Pole
Alt + + S Look towards South Celestial Pole

Table 3.2: Moving Around the Sky
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Hotkey Field of view Hotkey Field of view

Ctrl + Alt + 1 180� Ctrl + Alt + 6 10�

Ctrl + Alt + 2 90� Ctrl + Alt + 7 5�

Ctrl + Alt + 3 60� Ctrl + Alt + 8 2�

Ctrl + Alt + 4 45� Ctrl + Alt + 9 1�

Ctrl + Alt + 5 20� Ctrl + Alt + 0 0.5�

Table 3.3: Hotkeys to set �xed vertical �elds of view

As well as travelling through time, Stellarium lets you look around the sky freely, and zoom in
and out. There are several ways to accomplish this, listed in table 3.2.

Let’s try it. Use the cursors to move around left, right, up and down. Zoom in a little using
the Page key, and back out again using the Page . Press the \ key and see how Stellarium
returns to the original �eld of view (how �zoomed in� the view is), and direction of view.

If you prefer stepwise zooming to �xed values for �eld of view, table 3.3 lists the keys to reach
a certain �eld of view.

Most users prefer to move around using the mouse. If you left-click and drag somewhere on
the sky, you can pull the view around.

Another method of moving is to select some object in the sky (left-click on the object), and
press the Space key to centre the view on that object. Similarly, selecting an object and pressing
the forward-slash key / will centre on the object and zoom right in on it.

The forward-slash / and backslash \ keys auto-zoom in and out to different zoom levels
depending on what is selected. If the object selected is a planet or moon in a sub-system with a lot of
moons (e.g. Jupiter), the initial zoom in will go to an intermediate level where the whole sub-system
should be visible. A second zoom will go to the full zoom level on the selected object. Similarly, if
you are fully zoomed in on a moon of Jupiter, the �rst auto-zoom out will go to the sub-system
zoom level. Subsequent auto-zoom out will fully zoom out and return the initial direction of view.
For objects that are not part of a sub-system, the initial auto-zoom in will zoom right in on the
selected object (the exact �eld of view depending on the size/type of the selected object), and the
initial auto-zoom out will return to the initial FOV and direction of view.

If you have a touch screen, you can even use one �nger directly to drag the sky around and
select objects, and two �ngers to zoom. The support for touch screens is incomplete though, and
more advanced use of the program requires the classical operation with keyboard and mouse.

3.3 The Main Tool Bar

Stellarium can do a whole lot more than just draw the stars. Figure 3.2 shows some of Stellarium’s
visual effects including constellation line and boundary drawing, constellation art, planet hints, and
atmospheric halo around the bright Moon. The controls in the main tool bar provide a mechanism
for turning on and off the visual effects.

When the mouse is moved to the bottom left of the screen, a second tool bar becomes visible.
All the buttons in this side tool bar open and close dialog boxes which contain controls for further
con�guration of the program. The dialogs will be described in the next chapter.

Table 3.4 describes the operations of buttons on the main tool bar and the side tool bar, and
gives their default keyboard shortcuts.
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Figure 3.2: Night scene with constellation artwork and moon.

Feature Button Hotkey Description

Constellations C Draw constellations as �stick �gures�

Constellation Names V Draw name of the constellations

Constellation Art R Superimpose artistic representations
of the constellations

Constellation Boundaries B Draw boundaries of the constella-
tions1

Equatorial Grid E Draw grid lines for the equatorial co-
ordinate system of date (RA/Dec)

Azimuth Grid Z Draw grid lines for the horizontal co-
ordinate system (Alt/Azi)

Galactic Grid Draw grid lines for the galactic coor-
dinate system (Long/Lat)1

Equatorial J2000 Grid Draw grid lines for the equatorial co-
ordinate system at standard epoch
J2000.0 (RA/Dec) 1

Ecliptic Grid Draw grid lines for the ecliptic coor-
dinate system of date (Long/Lat)1
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Toggle Ground G Toggle drawing of the ground. Turn
this off to see objects that are below
the horizon.

Toggle Cardinal Points Q Toggle marking of the North, South,
East and West points on the horizon.

Toggle Compass Marks + Q Toggle degree marks along the hori-
zon.

Toggle Atmosphere A Toggle atmospheric effects. Most no-
tably makes the stars visible in the
daytime.

Deep-Sky Objects D Toggle marking the positions of
Deep-Sky Objects.

Planet Hints P Toggle indicators to show the posi-
tion of planets.

Nebula images I Toggle �nebula images�.1

Digitized Sky Survey Toggle �Digitized Sky Survey�
(TOAST).1

Hierarchical Progressive
Surveys

Ctrl + Alt + D Toggle �Hierarchical Progressive
Surveys�.1

Coordinate System Ctrl + M Toggle between horizontal (Alt/Azi)
& equatorial (RA/Dec) coordinate
systems.

Center Center the view on the selected ob-
ject

Night Mode Ctrl + N Toggle �night mode�, which applies
a red-only �lter to the view to be eas-
ier on the dark-adapted eye.

Full Screen Mode F11 Toggle full screen mode.

Bookmarks Alt + B Toggle bookmarks window.1

Flip view (horizontal) Ctrl + + H Flip the image in the horizontal
plane.1

Flip view (vertical) Ctrl + + V Flip the image in the vertical plane.1

Quit Stellarium Ctrl + Q Close Stellarium.

Help Window F1 Show the help window, with key
bindings and other useful informa-
tion

Con�guration Window F2 Show the con�guration window

Search Window F3 or Ctrl + F Show the object search window
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View Window F4 Show the view window

Time Window F5 Show the time window

Location Window F6 Show the observer location window
(map)

AstroCalc Window F10 Show the astronomical calculations
window

Table 3.4: Stellarium’s standard menu buttons. Those marked 1

must be enabled �rst, see section 4.3.5.

3.4 Taking Screenshots

You can save what is on the screen to a �le by pressing Ctrl + S . Screenshots are taken in
PNG format, and have �lenames like stellarium-000.png, stellarium-001.png (the number
increments to prevent overwriting existing �les).

The screenshots are stored to a directory depending on your operating system, see section 5.1
Files and Directories. See also section 4.3.5 for more screenshot options.

3.5 Observing Lists (Bookmarks)

You can store your favourite objects or views in observing lists. Press Alt + B or to call up

the dialog. A bookmarks �le from previous versions will be imported and converted to the new
format. You can however create an arbitrary number of lists.

The list display shows all entries from the current list. A double click on an entry selects the
object. To add/remove an object to/from the list, press Edit list . This changes the view. Highlight
(select) your object in the sky and press Add object . To remove an object from a list, select its
entry in the list and press Remove object .

Sometimes storing the object alone is not enough. Interesting views like planet conjunctions or
eclipses require at least a time entry, if not a particular location. Likewise, the displayed landscape
may be nice to restore. Additionally, the �eld of view may be relevant. To store these data and later
retrieve them, use the respective checkboxes.

You can also export the current list or all lists with the according button, or import such an
exported list on another system. To export the current list, keep the default .sol �le type in the
�lename dialog. To export all your lists, use the .ol �le type in the �lename dialog. Lists are
identi�ed with an Universally Unique Identi�er (UUID) which we call OLUD (Observing List
Unique Identi�er). On importing a list, existing lists with the same OLUD may be replaced after
a warning. During editing, storing a list with an existing name is prevented. The list import may
however import a list with an existing name as long as the OLUD is different. You may want to
change one of the duplicate list names after import. To transfer all your lists to another system,
export them as .ol �le, or copy, rename and import (or just copy, to replace the existing) the full
�le observingLists.json from the data/ subdirectory of your user directory (see section 5.1).
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3.6 Custom Markers

You can set temporary markers anywhere in the screen. These may be useful for various purposes
but cannot be stored.

Actions Description

Shift & left click Add custom marker
Shift & right click Delete the one closest marker to mouse cursor

Alt + & right click Delete all custom markers

3.7 Copy Information

If you have selected an object and want to use the displayed information elsewhere, you may
want to copy it to the system clipboard with Ctrl + + C . In case you want to use its numbers
elsewhere, please see Appendix F for known accuracy limitations.



4. The User Interface

This chapter describes the dialog windows which can be accessed from the left menu bar.

Most of Stellarium’s settings can be changed using the view window (press or F4 ) and

the con�guration window ( or F2 ). Most settings have short labels. To learn more about some

settings, more information is available as tooltips, small text boxes which appear when you hover
the mouse cursor over a button.1

You can drag the windows around, and the position will be used again when you restart
Stellarium. If this would mean the window is off-screen (because you start in windowed mode, or
with a different screen), the window will be moved so that at least a part is visible.

Some options are really rarely changed and therefore may only be con�gured by editing the
con�guration �le. See 5.4 The Main Con�guration File for more details.

4.1 Setting the Date and Time

Figure 4.1: Date and Time dialog

In addition to the time rate control buttons on the main toolbar, you can use the date and time

window (open with the button or F5 ) to set the simulation time. The values for year, month,

1Unfortunately, on Windows 7 and later, with some Nvidia and AMD GPUs in OpenGL mode, these
tooltips sometimes do not work.
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day, hour, minutes and seconds may be modi�ed by typing new values, by clicking the up and down
arrows above and below the values, and by using the mouse wheel.

The other tab in this window allows you to see or set Julian Day and/or Modi�ed Julian Day

numbers (see 18.4.2).

4.2 Setting Your Location

Figure 4.2: Location window

The positions of the stars in the sky is dependent on your location on Earth (or other planet) as well
as the time and date. For Stellarium to show accurately what is (or will be/was) in the sky, you
must tell it where you are. You only need to do this once � Stellarium can save your location so
you won’t need to set it again until you move.

After installation, Stellarium uses an online service which tries to �nd your approximate
location based on the IP address you are using. This seems very practical, but if you feel this causes
privacy issues, you may want to switch this feature off. You should also consider switching it off
on a computer which does not move, to save network bandwidth.

To set your location more accurately, or if the lookup service fails, press F6 to open the
location window (Fig. 4.2). There are a few ways you can set your location in this dialog:

1. Just click on the map.
2. Search for a city where you live using the search edit box at the top right of the window, and

select the right city from the list.
3. Click on the map to �lter the list of cities in the vicinity of your click, then choose from the

shortlist.
4. Enter a new location using the longitude, latitude and other data.
5. Click on Get Location from GPS if you have a GPS receiver. You activate a periodic request

for GPS �xes. After a few seconds, the button should change color and give a textual
feedback. Green indicates a good location �x, yellow indicates a 2D-�x only, which means
altitudes are not available. (Leave the GPS device running for a few minutes and/or search a
place with better sky view.) You could leave it running if you are operating a fast-moving
observatory platform, but rather switch it off when you see a good �x, so that other programs



4.2 Setting Your Location 21

can use the serial GPS connection. Red signals an error, and further positions are not
retrieved but the button is reset. You may press the button again to start over.
Sometimes you have to try several times or let it run for a while to get a green button
indicating a valid 3D �x including altitude. See section 5.5.4 for con�guration details.
On Windows, if there is no GPS device, a system location service will be queried as fallback. v 1.0

If you want to use the current location permanently, click on the �use as default� checkbox, disable
�Get location from Network�, and close the location window.

Two settings may in�uence the landscape when changing locations:
Auto select landscapes When changing the planet, a �tting landscape panorama will be shown

when available. Also, when clicking on the earth map, a zero-altitude landscape is displayed v 23.2
in the approximate color of that location (taken from the map).

Auto-enable atmosphere When changing planet during location change, the atmosphere will be
switched as required.

As a reverse functionality, loading landscapes may also change location. See section 4.4.5.

4.2.1 Time Zones

Locations in Stellarium’s location database include their respective time zone. When you click on a
location in the list, the time should be shown in the respective time zone. If daylight time rules exist
and you have selected �Enable daylight saving time�, also this abomination of modern civilisation
is respected. Most users will require to have this setting active.

When you select �Use custom time zone�, you can select other time zones. Those that start
with UTC have no daylight time rules.

Time zones were introduced in the 19th century, originally for purposes of railway traf�c
synchronization. The �rst such action was taken in 1847, and therefore Stellarium by default will
present Local Mean Solar Time (LMST) for dates before 1847, and ignore all con�gured time
zones unless you deliberately activate �Use custom time zone�. The history of time zones and their
rules is very complicated, though, and Stellarium should not be expected to �nd the exact date
when time zone use was introduced at a certain location or country. Just be sure to use LMST when
replaying historical observations before the 20th century.

For even earlier observations, you can also set Local True Solar Time (LTST), which is the
time given by sundials. Here, 12 o’clock is the time when the sun transits the meridian, strictly,
daily. The difference between LMST and LTST is called equation of time. See section 13.2 for
more information.

When you click on the map to set your location, Stellarium has currently no way to guess the
timezone of the coordinate pair. In this case, Local Mean Solar Time is presented, which only
depends on longitude and was the �normal� time before the development of time zones. Either
select a city from the list or manually select a time zone.

4.2.2 Geographical Regions

The world is split into political entities called �countries�. Humans have an unappealing tendency
of �ghting over the question to which country some territories should be counted. Stellarium is an
astronomy program which labels coordinates of locations like cities with a name. Earlier editions
of Stellarium used countries as further superordinate entities to locations for identi�cation purposes.
In consequence to much unnecessary and unfriendly discussion we decided to completely drop the
petty-minded assignment of political country names to locations in favour of geographical regions.
There is only one known habitable planet, one humankind, and one sky. Stellarium users should
overcome borders!

For the �region� classi�cation of sky cultures we use the same regions (see 9.2.1), and we
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follow the UN M49 geoscheme2 with extensions for other planets.

4.2.3 Observers

In the list of Planets you can �nd entries called Solar System Observer, Jupiter Observer and
similar for each major planet that has moons: Earth, Mars, Jupiter, Saturn, Uranus, and Neptune.
These are specialized locations. When switching to them, you will �nd yourself looking onto the
respective observed object (Sun, Jupiter, . . . ) from somewhat above the plane of the Solar system.
By pressing Alt + / Alt + you can rotate around a vertical axis through the observed object.
Likewise, by pressing Alt + / Alt + you can change the latitude of observation. Finally, with
Alt + Home / Alt + End you can change the distance from the observed object.

4.3 The Con�guration Window

The con�guration window contains general program settings, and many other settings which do not

concern speci�c display options. Press the tool button or F2 to open.

4.3.1 The Main Tab

Figure 4.3: Con�guration Window: Main Tab

The Main tab in the con�guration window (Fig. 4.3) provides controls for changing separately
the program and sky culture languages.

The next setting group allows to enable using DE430/DE431 and DE440/DE441 ephemeris
�les. These �les have to be installed separately. Most users do not require this. See section 5.5.3 if
you are interested.

The tab also provides the buttons for saving the current view direction as default for the next
startup, and for saving the program con�guration: most display settings have to be explicitly stored
to make a setting change permanent. If you prefer, you can activate Immediate Save . Then allv 24.4
settings changes will be stored immediately and the program will use them the next time you launch
it. Language and font settings have to be stored explicitly with the buttons next to their settings to
protect you from unwanted surprises. To permanently set this mode, use Save settings a �nal time.

2https://unstats.un.org/unsd/methodology/m49/
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4.3.2 The Information Tab

Figure 4.4: Con�guration Window: Information Tab

The Information tab (Fig. 4.4) allows you to set the type and amount of information displayed
about a selected object.

� Ticking or unticking the relevant boxes will control this.
� The information displays in various colors depending on the type and level of the stored data

4.3.3 The Extras Tab

Figure 4.5: Con�guration Window: Extras Tab

The Extras tab (Fig. 4.5) allows you to customize information displayed about a selected object,
download more star catalogs and also allows to hide or show additional buttons in the lower button
bar.
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Customization of information displays

The information display can be tweaked a bit with the options found in the GUI section �Additional
information settings�.
Use mag/arcsec�2 for surface brightness instead of mag/arcmin�2.
Short notation for units of surface brightness symbolic abbreviation.
tabular output for coordinates and time uses a more eye-friendly layout.
Azimuth from South Some users may be used to counting azimuth from south.
Use decimal degrees You can toggle usage of decimal degree format for coordinates.
Designations for celestial coordinate systems Use symbols like a;d instead of textual labels.

Customization of button visibility on bottom toolbar

If your screen is too narrow to show all buttons or you simply don’t need them because you prefer
the keyboard shortcuts, you can choose your optimal setup. The selection of buttons is stored
immediately.
Constellation boundaries You can toggle display of constellation boundaries with this button.
Asterism lines You can toggle display of asterism lines with this button.
Asterism labels You can toggle display of asterism labels with this button.
Ecliptic grid You can toggle display of ecliptic coordinate grid with this button.
ICRS grid You can toggle display of the International Coordinate Reference System (equatorial

J2000 coordinate grid) with this button.
Galactic grid You can toggle display of galactic coordinate grid with this button.
Cardinal points You can toggle display of the �Cardinal points� button.
Compass marks You can toggle display of the �Compass marks� button.
Night mode You can toggle display of the nightmode button.
Centering button You can toggle display of the �Center on selected object� button.
Fullscreen button You can toggle display of the fullscreen button.
Quit button You can toggle display of the button to quit Stellarium.
Nebula background You can toggle display of DSO photographs with this button.
Flip buttons When enabled, two buttons will be added to the main tool bar which allow the main

view to be mirrored in the vertical and horizontal directions. This is useful when observing
through telecopes which may cause the image to be mirrored.

DSS survey You can toggle display of Digitized Sky Survey with this button (see section 10.4).
HiPS Surveys You can toggle display of Hierarchical Progressive Surveys with this button (see

section 4.4.7).
Bookmarks You can enable display of Bookmarks (Observing Lists) dialog with this button.
Use buttons background Applies a gray background under the buttons on the bottom bar.

Download more star catalogs

Stellarium comes with enough stars for casual stargazing with the unaided eye or binoculars. If
you have a telescope and want to see more stars, here you can download more catalogs. (See
Appendix C)

4.3.4 The Time Tab

The Time tab (Fig. 4.6) allows to specify what simulation time should be used when the program
starts:
System date and time Stellarium will start with the simulation time equal to the operating system

clock.
System date at Stellarium will start with the same date as the operating system clock, but the

time will be �xed at the speci�ed value. This is a useful setting for those people who use
Stellarium during the day to plan observing sessions for the upcoming evening.
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Figure 4.6: Con�guration Window: Time Tab

Other some �xed time can be chosen which will be used every time Stellarium starts.
The middle �eld allows specify display formats for date and time on bottom toolbar:
JD Stellarium will display Julian Days (JD).
Date and time Stellarium will display date and time in selected format.
The lowest �eld allows selection of the correction model for the time correction DT (see sec-
tion 18.4.3). Default is �Modi�ed Espenak and Meeus (2006, 2014, 2023)�. Please use other values
only if you know what you are doing.

4.3.5 The Tools Tab

The Tools tab (Fig. 4.7) contains planetarium options (like enabling/disabling of keyboard shortcuts
for panning and zooming the main view) and options for screenshots.
Spheric mirror distortion This option pre-warps the main view such that it may be projected

onto a spherical mirror using a projector. The resulting image will be re�ected up from the
spherical mirror in such a way that it may shine onto a small planetarium dome (or even just
the ceiling of your dining room), making a cheap planetarium projection system.

Disc viewport This option masks the main view producing the effect of a telescope eyepiece. It is
also useful when projecting Stellarium’s output with a �sh-eye lens planetarium projector.

Gravity labels This option makes labels of objects in the main view align with the nearest horizon.
This means that labels projected onto a dome are always aligned properly.

Auto zoom out returns to initial direction of view When enabled, this option changes the behav-
ior of the zoom out key \ so that it resets the initial direction of view in addition to the
�eld of view.

Enable keyboard navigation , i.e. moving the view with cursor keys. The tool button calls the
keyboard con�guration panel. (See section 4.8.)

Enable mouse navigation , i.e. mouse dragging.
Enable mouse zooming use mouse wheel to zoom �eld of view.
Mouse cursor timeout You can decide whether, and when, the mouse cursor should disappear
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Figure 4.7: Con�guration Window: Tools Tab

from view when not moved.
Include Topocentric coordinates If you require planetocentric coordinates, you may switch this

off. Usually it should be enabled. (See 18.9.1)
Nutation Compute the slight wobble of earth’s axis. This feature is active only about 500

years around J2000.0.
Aberration Add effect of annual aberration of light to the object’s position (see 18.10).

Note: This also in�uences the displayed position in the J2000 frame! For didactic
purposes you can exaggerate the effect by up to 5�.

Overwrite text color � enabling this option will ignore the color settings for each celestial object
and enable one color for text on the info panel for all celestial objects. By default Stellarium
uses white color for this option, but you may re-de�ne it through a color chooser.

Set keyboard focus to day input � you may use this option to force setting the keyboard focus
on the day input �eld in the Date and Time dialog.
Important note: the focus in the sky will be lost when you open the Date and Time dialog
after enabling this option.

Use kinetic scrolling Text �elds in dialogs can either be moved on sidebar handles (with this
switch disabled) or by dragging the text itself (enabled), as it is known from touch-enabled
devices like smartphones.

Dithering options to allow select better simulation of sky on different hardware.
Indication for mount mode You can activate the short display of a message when switching type

of used mount.
Info text color at daylight � this is a color chooser for de�ning the text color for the info panel

at daylight to increase the contrast of the text. By default Stellarium use black color.

Multithreading

For every frame, the positions of all planets and minor bodies of the Solar system are computed.
Most of the other time between frame updates is needed for the actual frame drawing, and waiting
for the next frame cycle if you have deliberately set a low frame rate (useful to conserve energy;
see below). If you have many thousands of solar system objects and a moderately new computer,
you may feel that Stellarium becomes slow (few frames/second) but see that mostly only one core
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of your CPU seems to be busy. You can try to distribute the computation of solar system bodies to v 24.3
more CPU cores. But take note, thread synchronization (combining all results ahead of drawing)
takes its time, so it pays off only when your solar system is really large. With more than 1000
objects, we recommend starting with 1 additional thread. Even with 25.000 objects, assigning more
than 4 additional threads on a 20-core CPU does not show any further gain. Frame drawing is still
performed by the main thread, and too many objects still slow down the program. Just try out what
works best on your system.

Framerate intent

The pace of screen updates (frames per second, FPS) depends on several factors: CPU speed,
graphics card speed, screen size, number of displayed objects and grids, etc. As is common for
interactive programs, the main program thread runs on a single core also on a multicore system.
For running Stellarium, a CPU with few but fast cores will appear faster in total than a multicore
system at slower CPU cycles. High-end systems may deliver needlessly high framerates, at
cost of energy consumption. The maximum FPS setting limits the frame rate when Stellarium
is interactively operated (zoomed, panned, settings switched, etc.) After a few seconds, when
Stellarium is not interactively operated, it falls back to a minimum FPS setting to conserve energy.
Of course, when the system cannot even reach this FPS, the factual FPS will be lower and the
system may be overloaded. Keep in mind that the minimum setting also applies to running scripts
(non-interactively).

Font size and font selection

You can change the font sizes for on-screen text and GUI dialogs separately. For some purposes like
presentations it may be helpful to enlarge screen font size while keeping GUI font regular, or vice
versa. It also depends on your screen size whether all the object info �ts on screen. This may also
depend on the writing system and installed font. If you are using a non-Western character system
and the default font looks bad, you can select another system font. For this, edit config.ini (see
chapter 5.1): locate the [gui] section and set the key flag_font_selection=true. On next
start of Stellarium, you will �nd two elements for font selection: one allows you to pre-select a
writing system, the other will then allow selection of a font installed in your system that includes
the characters used in the selected writing system. When you have found the best font, store your
settings here or on the Main tab (see section 4.3.1), and you may edit config.ini again to disable
the font selection switches.

Screenshots

You can set the directory where screenshots will be stored, and also whether you want screenshots
sized like Stellarium’s window or some other, likely larger size. The maximum possible size
depends on your hardware. 4096 � 4096 should be possible on most PCs, others may even create
16384� 16384 images. The vertical �eld of view will be the same as in the current view.

You can also set the �le format. The exact selection depends on platform and version of the
underlying Qt framework. Notable formats are PNG (lossless), JPG (lossy), JPEG (higher quality
JPG), BMP (Windows Bitmap), WEBP, TIF (LZW compressed), TIFF (uncompressed), PBM,
PGM, PPM, XBM, XPM, and ICO (thumbnails).

Some printing work�ows require particular DPI (dots per inch) settings stored in the screenshots.
You can con�gure DPI which will be stored in the image metadata. The intended print size in mm
is shown in the tooltip of the dpi spinner.

4.3.6 The Scripts Tab

The Scripts tab (Fig. 4.8) allows the selection of pre-assembled scripts bundled with Stellarium that
can be run (See chapter 17 for an introduction to the scripting capabilities and language). This list



28 Chapter 4. The User Interface

Figure 4.8: Con�guration Window: Scripts Tab

can be expanded with your own scripts as required. See section 5.2 where to store your own scripts.

When a script is selected it can be run by pressing the arrow button and stopped with the stop
button. With some scripts the stop button is inhibited until the script is �nished.

Scripts that use sound or embedded videos will need a version of Stellarium con�gured at
compile time with multimedia support enabled. It must be pointed out here that sound or video
codecs available depends on the sound and video capabilities of you computer platform and may
not work.

4.3.7 The Plugins Tab

Plugins (see chapter 12 for an introduction) can be enabled here (Fig. 4.9) to be loaded the next
time you start Stellarium. When loaded, many plugins allow additional con�guration which is
available by pressing the con�gure button on this tab.

4.4 The View Settings Window

The View settings window controls many display features of Stellarium which are not available via
the main toolbar.

4.4.1 The Sky Tab

The Sky tab of the View window (Fig. 4.10) contains settings for changing the general appearance
of the main sky view and projections. Some highlights of sky �eld:
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Figure 4.9: Con�guration Window: Plugins Tab

Figure 4.10: View Settings Window: Sky Tab
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Dynamic eye adaptation When enabled this feature reduces the brightness of faint objects when
a bright object is in the �eld of view. This simulates how the eye can be dazzled by a bright
object such as the moon, making it harder to see faint stars and galaxies.

Light pollution In urban and suburban areas, the sky is brightened by terrestrial light pollution
re�ected in the atmosphere. Stellarium simulates light pollution and lets the user con�gure
how bright the night sky is. There are several ways to set it up:
Automatic from locations database option makes Stellarium �nd sky brightness from its

locations database and simulate light pollution without any further user input.
Manual mode lets the user choose the amount of light pollution by moving a slider. To

make it easier to orient in the resulting amount of light pollution, a tooltip will show
the classi�cation of the sky according to the Bortle Dark Sky Scale (See Appendix B
for more information), as well as the naked-eye limiting magnitude.

Manual from SQM mode lets one enter the reading of a Sky Quality Meter. Stellarium can
accept it in several units: physical (cd=m2, mcd=m2, mcd=m2) as well as astronomical,
mag=arcsec2. To enter a value, �rst choose the unit, and then type the number into the
spinbox.

Solar altitude for Twilight Finder You can con�gure shortcut keys to go to the time when the
sun reaches this altitude below the mathematical horizon. See section 4.8.1.

Shooting stars Stellarium has a simple meteor simulation option. This setting controls how many
shooting stars will be shown. Note that shooting stars are only visible when the time rate is
1, and might not be visible at some times of the day. Meteor showers can be simulated using
a dedicated plugin (see section 14.6).

Some highlights of the stars �eld:
Absolute scale is the size of stars as rendered by Stellarium. If you increase this value, all stars

will appear larger than before.
Relative scale determines the difference in size of bright stars compared to faint stars. Values

higher than 1.00 will make the brightest stars appear much larger than they do in the sky.
This is useful for creating star charts, or when learning the basic constellations.

Twinkle controls how much the stars twinkle when atmosphere is enabled (scintillation, see
section 19.13.2). Since v0.15.0, the twinkling is reduced in higher altitudes, where the star
light passes the atmosphere in a steeper angle and is less distorted.

Limit magnitude Inhibits automatic addition of fainter stars when zooming in. This may be
helpful if you are interested in naked eye stars only.

Labels and markers you can independently change the amount of labels displayed for stars. The
further to the right the sliders are set, the more labels you will see. Note that more labels
will also appear as you zoom in.

Use designations for screen labels � when this option is enabled you will see in the sky (on-
screen labels) only scienti�c designations (catalog numbers) of the stars instead of their
common names. To customize the on-screen labels we added 3 additional options3 � Dbl.

stars, Var. stars and HIP � which will show, in this sequence of preference, the �rst
available occurrence of the traditional designations of double stars, variable stars or HIP
numbers, respectively.

The Projections �eld

Selecting items in this list changes the projection method which Stellarium uses to draw the
sky (Snyder, 1987). Options are:
Perspective Perspective projection maps the horizon and other great circles like equator, ecliptic,

hour lines, etc. into straight lines. The maximum �eld of view is 150�. The mathematical

3These options are only used if the star does not have Bayer/Flamsted designations.
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name for this projection method is gnomonic projection.
Stereographic Stereographic projection has been known since antiquity and was originally known

as the planisphere projection. It preserves the angles at which curves cross each other but it
does not preserve area. Else it is similar to �sh-eye projection mode. The maximum �eld of
view in this mode is 235�.

Fish-Eye Stellarium draws the sky using azimuthal equidistant projection. In �sh-eye projection,
straight lines become curves when they appear a large angular distance from the center of
the �eld of view (like the distortions seen with very wide angle camera lenses). This is more
pronounced as the user zooms out. The maximum �eld of view in this mode is 180�.

Orthographic Orthographic projection is related to perspective projection, but the point of per-

spective is set to an in�nite distance. The maximum �eld of view is 180�.
Equal Area The full name of this projection method is Lambert azimuthal equal-area projection.

It preserves the area but not the angle. The maximum �eld of view is 360�.
Hammer-Aitoff The Hammer projection is an equal-area map projection, described by ERNST

VON HAMMER (1858�1925) in 1892 and directly inspired by the Aitoff projection. The
maximum �eld of view in this mode is 360�.

Sinusoidal The sinusoidal projection is a pseudocylindrical equal-area map projection, sometimes
called the Sanson�Flamsteed or the Mercator equal-area projection. Meridians are mapped
to sine curves.

Mercator Mercator projection is a cylindrical projection developed by GERARDUS MERCATOR

(1512�1594) which preserves the angles between objects, and the scale around an object is
the same in all directions. The poles are mapped to in�nity. The maximum �eld of view in
this mode is 233�.

Miller cylindrical The Miller cylindrical projection is a modi�ed Mercator projection, proposed
by OSBORN MAITLAND MILLER (1897�1979) in 1942. The poles are no longer mapped to
in�nity.

Cylinder The full name of this simple projection mode is cylindrical equidistant projection or
Plate CarrØe. The maximum �eld of view in this mode is 233�.

Two more settings allow �netuning:

Vertical viewport offset If you have a wide screen or like wide-angle views, you may feel that
too much of screen space lies below the horizon. This setting can shift the view up or down.

Custom FoV limit Some projections allow very wide views, like 180� which covers a complete
celestial hemisphere (e.g. the entire skydome) or even more. In some cases like if you are
running a planetarium, you may want to limit the vertical �eld of view so that you won’t
ever zoom out too far.

Atmosphere settings

An auxiliary dialog opens when you select and contains detail settings for the atmosphere.
Here you can choose visual model of atmosphere, set atmospheric pressure and temperature which
in�uence refraction (see section 19.13.2) and the opacity factor kv for extinction, magnitude loss

per airmass (see section 19.13.1).

There are two visual models for the atmosphere available:

Preetham This is the legacy model (see section 11.2.1), fallback for the cases when the other one
doesn’t work.

ShowMySky This model is the more realistic visual model of the atmosphere colors (see sec-
tion 11.2.2). It relies on a precomputed dataset that can be chosen in the user interface after
the ShowMySky model is enabled.
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4.4.2 The Solar System Objects (SSO) Tab

The Solar System Objects tab of the View window (Fig. 4.11) contains settings for changing the
general appearance of the view of Solar system objects. Some highlights:

Figure 4.11: View Settings Window: SSO Tab

Simulate light speed will give more precise positions for planetary bodies which move rapidly
against background stars (e.g. the moons of Jupiter).

Scale will increase the apparent size of the selected class of objects:
Moon will increase the apparent size of the Moon in the sky, which can be nice for wide

�eld of view shots.
Minor bodies will increase the apparent size of minor bodies: planet satellites, all kinds of

asteroids, and comets. Forsome of these 3D models are available, which will be better
discernible if enlarged.

Sun will increase the apparent size of the Sun in the sky, which can be nice for didactic
purposes or demonstrations.

Planets will increase the apparent size of major planets.
Mark minor bodies Show a little circle at the location of every minor body (comet, asteroid,v 24.3

. . . ), down to the con�gured visual magnitude. The marks are shown regardless of sky
brightness, even in daytime. Also, in this mode, markers for objects with highly outdated
orbital elements are still plotted (see 13.8 and Appendix D.2.2). This is useful to show the
distribution of asteroids and comets on the sky, or especially when viewed from the Solar
System Observer (see 4.2.3).
From the �Observer� viewpoints, the visual magnitude for minor bodies is computed as seen
from the Sun, so that objects in inferior conjunction ae not dimmed down and �ltered away
by effects of phase angle, and comet tails are better visible.

Show orbits adds a rendition of the orbit or trajectory of an SSO. For ef�ciency, orbits are not
displayed when the object is not inside the screen, unless you set the �permanently� option.
You can further �ne-tune the selection and appearance (width and colors) of orbits with the
additional settings.

Show trails plots the apparent path of SSO among the stars as seen from the current planet.
Show planetary nomenclature displays positions and names of surface features of�cially named

by the IAU (See Appendix E). When the sun is below the horizon at the location of the
feature, the label is attenuated. A few special markers show Centre, North and South poles,
east and west points along the equator, and the subsolar point (where the sun is at the zenith
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as seen from that feature). Features like craters are best visible when they are illuminated
by a low sun. You can therefore limit the display to items along the terminator (the border v 1.2
between light and dark on the surface). You can also mark craters and lunar maria (the dark v 23.3
�seas�) with circles.

GRS details. . . : The Great Red Spot (GRS) is slowly drifting along Jupiter’s System II coordinate
system. This button opens a new dialog in which you can adjust the longitude (Jupiter
system II) and annual drift rate of this feature at a particular epoch. To help you, another
button in this dialog opens a website with relevant data. The central meridian data given in
the object information on screen still shows System II longitude.

Labels and markers you can independently change the amount of labels displayed for Solar
system objects. The further to the right the sliders are set, the more labels you will see. Note
that more labels will also appear as you zoom in.

Planet magnitude algorithm several ways to compute planet magnitudes have been made avail-
able from the literature. Data by Müller (1893) provide visual magnitudes. The other models
provide instrumental (Johnson V) magnitudes.

Earth shadow enlargement after Danjon Earth’s shadow is enlarged by the atmosphere. You
can select whether the 2% enlargement used by the Astronomical Almanac should be applied
(default), or the formulation of DANJON (see section 19.11.2).

4.4.3 The Deep-Sky Objects (DSO) Tab

Deep-sky objects or DSO are extended objects which are external to the solar system, and are not
point sources like stars. DSO include galaxies, planetary nebulae and star clusters. These objects
may or may not have images associated with them. Stellarium comes with a catalog of over 90,000
extended objects containing the combined data from many catalogs, with 500+ images.

The DSO tab (Fig. 4.12) allows you to specify which catalogs or which object types you are
interested in. This selection will also be respected in other parts of the program, most notably
Search (section 4.5) and AstroCalc/WUT (section 4.6.6) will not �nd objects from catalogs which
you have not selected here.

See chapter 8 for details about the catalog, and how to extend it with your own photographs.

4.4.4 The Markings Tab

The Markings tab of the View window (Fig. 4.13) controls plotting various grids and lines on the
celestial sphere. Colors for grids, lines and points can be adjusted by clicking on the corresponding
colored square. The central column governs lines like equator, ecliptic, meridian etc., where
each can optionally be �ne-tuned to show partition marks and labels. Color settings are stored
immediately, all other �ags need explicit saving of the settings (see section 4.3.1).

4.4.5 The Landscape Tab

The Landscape tab of the View window (Fig. 4.14) controls the landscape graphics (the horizon
which surrounds you). To change the landscape graphics, select a landscape from the list on the left
side of the window. A description of the landscape will be shown on the right.

Note that while a landscape can include information about where the landscape graphics were
taken (planet, longitude, latitude and altitude), this location does not have to be the same as the
location selected in the Location window, although you can set up Stellarium such that selection of
a new landscape will alter the location for you.

The controls at the bottom right of the window operate as follows:
Use this landscape as default Selecting this option will save the landscape into the program

con�guration �le so that the current landscape will be the one used when Stellarium starts.
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Figure 4.12: View Settings Window: DSO Tab

Figure 4.13: View Settings Window: Markings Tab

Figure 4.14: View Settings Window: Landscape Tab
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Show ground This turns on and off landscape rendering (same as the button in the main tool
bar).

Show fog This turns on and off rendering of a band of fog/haze along the horizon, when available
in this landscape.

Show illumination to re�ect the ugly developments of our civilisation, landscapes can be con�g-
ured with a layer of light pollution, e.g., streetlamps, bright windows, or the sky glow of a
nearby city. This layer, if present, will be mixed in when it is dark enough.

Show landscape labels Landscapes can be con�gured with a gazetteer of interesting points, e.g.,
mountain peaks, which can be labeled with this option. Color and font size can also be
con�gured.

Location from landscape When enabled, selecting a new landscape will automatically update the
observer location. Use this if the landscape is not just decoration, but a true representation of
a particular site you wish to visit in the simulation.

Minimal brightness Moonless night on very dark locations may appear too dark on your screen.
You may want to con�gure some minimal brightness here.
from landscape, if given Landscape authors may decide to provide such a minimal bright-

ness value in the landscape.ini �le.
Draw only polygon If a polygonal horizon line has been de�ned for the landscape, only draw this

with the given thickness and color.
Transparency Allow peeking below the horizon. Note that this may show graphical errors. v 23.3
Using the button Add/remove landscapes. . . , you can also install new landscapes from ZIP �les
which you can download e.g. from the Stellarium website4 or create yourself (see ch. 7 Landscapes),
or remove these custom landscapes.

Loading large landscapes may take several seconds. If you like to switch rapidly between
several landscapes and have enough memory, you can increase the default cache size to keep more
landscapes loaded previously available in memory. Note that a large landscape can take up 200MB
or more! See section D.1.13.

4.4.6 The Sky Culture Tab

If you want to explore humankind’s cultural history, you could also switch to the viewpoint of other
ancient or contemporary people. Constellations are de�ned as patterns in the sky serving to set
calendar marks and to navigate while travelling on Earth. Which patterns are seen depends on the
natural environment and the cultural habits of the people, i.e., the Inuit in the arctic area might have
seen an Elk where the Chinese have seen a huge spoon or dipper. There cannot be any astrological
in�uence from these patterns as they had been seen differently and, thus, are a product of human’s
imagination. So, pointing out these cultural differences might have an educational function, too.

Caution

Some of our native peoples’ constellations are contributed for noncommercial use only. Please
respect their heritage holders and check-out the CC licence version in the description before you
use sky cultures for broadcasting! See section 9.1.2 for details.

The Sky Culture tab of the View window (Fig. 4.16) controls which culture’s constellations
and bright star names will be used in the main display. Some cultures have constellation art (e.g.,
Western and Inuit), and the rest do not. Con�gurable options include
Use this sky culture as default Activate this option to load this sky culture when Stellarium starts.
Constellations name style You can select whether you want to display abbreviated, original or

translated names.

4https://stellarium.org/landscapes.html

https://stellarium.org/landscapes.html
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Figure 4.15: World map showing Stellarium’s built-in set of sky cultures. To avoid
overcrowding, smaller European sky cultures which are mostly derivatives or relatives of
the �Modern� sky culture are not shown. (Image: S. M. Hoffmann)

Figure 4.16: View Settings Window: Sky Culture Tab

Use native names for planets If provided, show the planet names as used in this sky culture (also
shows modern planet name for reference).

Constellation labels Activate display of constellation labels, like or V .

Constellation lines Activate display of stick �gures, like or C , and you can con�gure
constellation line thickness in the right spinbox.

Constellation boundaries Activate display of constellation boundaries, like B . Currently,
boundaries have been de�ned only for �Modern� sky cultures.

Art in brightness. . . Activate display of constellation art (if available), like or R . You can
also select the brightness here.

Asterism labels Activate display of asterism labels, like Alt + V .
Asterism lines Activate display of asterism stick �gures (like the shortcut Alt + A ), and you can
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con�gure asterism line thickness as well.
Ray helpers Activate display of special navigational lines which connect stars often from different

constellations (like the shortcut Alt + R ), and you can con�gure thickness of those lines as
well.

Select single constellation/Isolated See section 4.4.6 for details.

Select single constellations

Some presenters may want to explain a particular storyline about the constellations of a sky culture,
which includes showing single constellations or showing a sequence of appearing constellations.
To achieve this, �rst activate �Select single constellation� mode (see �g 4.16). Then, click on a star
which is part of a constellation line set. Click another star which is part of another constellation
to show that one in addition. If you really only want to show a single constellation, also add the
�Isolated� option.

If you explain a sky culture where constellations also have borders de�ned, a click anywhere in
the constellation area is enough. For other sky cultures, clicking onto a star which is not member of
a constellation line will display all constellations.

Press W to remove all but the last selected constellation. If you had deleted selection (right
mouse click) before pressing W , all constellations are hidden. Press W again to also hide the
single displayed one, or click another star to select the next constellation. If you need to keep the
single constellation visible, select the currently selected star again to select it again. Press Alt + W

to show all constellations.
With a little training, you will be able to give inspiring constellation tours.

4.4.7 The Surveys Tab

Figure 4.17: View Settings Window: Surveys Tab

The Surveys tab (Fig. 4.17) allows to toggle the visibility of online sky or solar system surveys
(see chapter 10 for description of the surveys format). Currently, only HiPS surveys are supported.

On the left side of the window we see the list of available surveys from the con�gured sources
(See section D.1.29 for how to change the default sources). On the right side a description of the
selected survey and its properties are displayed.

Surveys are grouped by types. The top combobox allows to �lter the listed surveys according
to a given type (Deep Sky or Solar System).
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You can toggle the visibility of a survey by checking the box on the left of the survey name
in the list. (Note that as of v0.18.0, only a single deep sky survey can be rendered at a time, so it
makes no sense to select more than one in the list!) Once a survey is visible you should be able to
see its loading status in the loading bar area of the sky view.

Deep sky surveys will be rendered aligned with the sky view, while solar system surveys
automatically map on the proper body.

4.5 The Search Window

4.5.1 The Object tab

The Object tab of the Search window provides a convenient way to locate objects in the sky. Simply
type in the name of an object to �nd, and press . Stellarium will point you at that object in the
sky.

As you type, Stellarium will make a list of objects which contains what you have typed so
far. The �rst of the list of matching objects will be highlighted. If you press the or key,
the selection will change to the next item in the list. Pressing the key will bring you to the
previous item. Hitting the key will center on the currently highlighted object and close the
Search window.

For example, suppose we want to locate Saturn’s moon Mimas (SI). Open the Search window

( , F3 , or Ctrl + F ). Type the �rst letter of the name, m, to see a list of objects whose name

contains m:

Miranda (UV)
Psamathe (NX)
Umbriel (UII)
. . .

You may want at this point to have Stellarium rather propose object names which start with the
string you enter. Do that in the Options tab of this panel (see section 4.5.5). The search result
should update automatically when you navigate back to the Object tab. Now the list is shorter and
contains only objects which start with m:

Mago
Maia
Mars
. . .

The �rst item in this list, Mago, is highlighted. Pressing now would go to Mago, but we want
Mimas (SI). We can either press or a few times to highlight Mimas (SI) and then hit ,
or we can continue to type the name until it is the �rst/only object in the list.

After you searched for an object, the next time the Search window opens, your most recently
searched object(s) will automatically appear in the search result of the Object tab. For instance,
continuing with our example, re-open the Search window’s Object tab. Mimas (SI) should already
be populated and highlighted:

Mimas (SI)

The Object tab’s search result will now prioritize your most recent searches (which will be shown
in bold). To modify the search results, see section 4.5.5. From our earlier example, re-enter m into
the Object tab. Doing so will generate a slightly different list than before. In this case, Mimas (SI)
will appear �rst, as shown in Figure 4.19:
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Figure 4.18: The Search Window: Object

Figure 4.19: The Search Window: Object (Recent Searches)

Figure 4.20: The Search Window: SIMBAD
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Figure 4.21: The Search Window: Position

Figure 4.22: The Search Window: Lists

Figure 4.23: The Search Window: Options
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Mimas (SI)

Mago
Maia
Mars
. . .

4.5.2 The SIMBAD tab

The SIMBAD tab (Fig. 4.20) provides a convenient way to fetch and show a set of information for
selected object from the astronomical online database SIMBAD (Wenger et al., 2000). If some
object is only visible in a survey or DSS background (see section 10) and not in Stellarium’s
catalogs, you can also set a custom marker (see section 3.6), select it and query SIMBAD �tell me
what’s known about objects at this location�.

4.5.3 The Position tab

The Position tab (Fig. 4.21) provides a convenient way to enter a set of coordinates.

4.5.4 The Lists tab

The Lists tab (Fig. 4.22) allows selection of an object from prede�ned sets. The number of choices
is governed by the loaded DSO catalogs and plug-ins. Scroll down the �rst window to select the
type. Click on the name and Stellarium will center on that object.

4.5.5 The Options tab

The Options tab (Fig. 4.23) provides a few settings to �ne-tune your search experience.
Use SIMBAD When the name of an object to �nd is typed in the Object tab and you are connected

to the internet and �Use SIMBAD� is ticked, Stellarium will search the SIMBAD on-line

databases for its coordinates. You can then click the button or press . Stellarium
will point you at that object in the sky even if there is no object displayed on the screen. The
SIMBAD server being used can be selected from the scroll window.
Server: for server selection

Search Options group allows for changes in the search result behaviour.
Use auto�ll only from the beginning of words when checked, will search for object names

that begins with the same letters as your input. Example provided in section 4.5.1.
Lock position when coordinates are used

Show FOV center marker when position is search

Recent Searches group allows modi�cation to your recent search data. Any changes here will
automatically update the search results displayed in the Object tab. Example provided in
section 4.5.1.
Max items to display amount of recent searches that can appear in the search result

button deletes your recent search history

4.6 The Astronomical Calculations Window

This window provides advanced functionality, some of which is still under development. You can

call it by pressing F10 or the button on the left menu bar. The Astronomical Calculations
window shows eight tabs with different functionality.

Most tabs allow exporting computed data to XLSX (Excel) �les in addition to CSV �les, and
graphs can be exported as PNG �les.
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4.6.1 The Positions Tab

This tab shows equatorial J2000.0 or horizontal positions, magnitudes and additional parameters
(e.g. surface brightness for deep-sky objects or angular separation for double stars) for various lists
of celestial objects above the horizon at the simulated time, �ltered by magnitude. Double-clicking
on an entry brings the object into focus (Fig. 4.24). You may also export the list of positions into an
XLSX or CSV �le.

Figure 4.24: Astronomical Calculations (AstroCalc): Celestial positions / Seen now

This tab is split into 2 subtabs: �Seen now� and �Major planets�. The �Major planets� subtab
(Fig. 4.25) shows a table with heliocentric ecliptic positions of the major planets and a graphical
representation of these positions (in polar coordinates). You may also export the list of positions
into an XLSX or CSV �le.

Figure 4.25: Astronomical Calculations (AstroCalc): Celestial positions / Major Planets

4.6.2 The Ephemeris Tab

Select an object, start and end time, and compute an ephemeris (list of positions and magnitudes
evolving over time) for that object. The positions are marked in the sky with yellow disks (Fig. 4.26).
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Figure 4.26: Astronomical Calculations (AstroCalc): Plot trace of planet

Figure 4.27: Astronomical Calculations (AstroCalc): Extra options for ephemeris

Figure 4.28: Astronomical Calculations (AstroCalc): Analemma on the Earth
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When you click on a date, an orange disk indicates this date and/or magnitude. Double-clicking
sets the respective date and brings the object to focus. Dates and/or magnitudes will show up near
position markers when Show dates and/or Show magnitudes checkboxes are active. To show a line
between markers please tick checkbox Show line. You may customize the format of displayed data
near markers and their frequency in the Extra options window (Fig. 4.27). You can also de�ne the
color of markers and enable display markers for all naked-eye visible planets.

You can export the calculated ephemeris into an XLSX or CSV �le.
Another interesting option in this tool: using horizontal coordinates for plotting traces of the

Solar system objects. In this mode, the circle marks are not linked to the sky, but to the horizontal
coordinate system. For example, you can get an analemma of the Sun for any location (Fig. 4.28
and 4.29), or observe the visibility of Mercury, Venus or a comet in the twilight sky.

You can draw an ephemeris of two objects at the same time and de�ne custom time step for
the ephemeris (Fig. 4.30).

Note: The ephemeris is computed with the current settings for atmosphere, topocentric correc-
tion etc. In consequence, e.g. magnitudes may be affected by atmospheric absorption and may show
unexpected values. Remember to switch off atmosphere etc. to create extinction free geocentric
mean positions as found in almanachs.

4.6.3 The �Risings, Transits, and Settings� (RTS) Tab

This tab allows you to compute meridian transits and rising and setting times of selected celestial
object (except unnamed stars and arti�cial satellites) for a speci�c date range. The tool is useful
for planning observations, and it suggests the best time and conditions for visual observations or
astrophotography (Fig. 4.31).

You may also export the list of transits into an XLSX or CSV �le.

4.6.4 The Phenomena Tab

This tab allows you to compute phenomena like conjunctions, oppositions, occultations and eclipses
(in special cases) between planetary objects (Fig. 4.32). In addition, it provides computation of
greatest elongations for the inner planets and stationary points for all planets, and, for all Solar
system bodies except the moons, we also compute perihelia and aphelia.

You can export the calculated phenomena into an XLSX or CSV �le.
Four columns in the table may be helpful for planning observation of phenomena:

solar elongation angular distance from the Sun
lunar elongation angular distance from the Moon
mag. 1 magnitude of �rst object
mag. 2 magnitude of second object

4.6.5 The Graphs Tab

This tab provides on several sub-tabs graphs which are helpful for monthly observation planning of
deep-sky objects and analysis of changes between objects or changes of their positions. Clicking in
the graph sets the time at that point, and setting the mouse onto a graph displays values at this point.
However, most graphs are intended for a rapid overview and are plotted using an interpolating
spline through sparse samples, so do not expect highest accuracy.

The �Altitude vs. Time� Subtab

On this subtab (the �rst subtab and default view in the Graphs tab) you can compute the geometrical
altitude of the currently selected object on the currently set date and draw it as a graph (Fig. 4.33).

Optional graphs for the Sun (with lines for civil, nautical and astronomical twilight) and the
Moon (dashed) are also available.
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Figure 4.29: Astronomical Calculations (AstroCalc): Analemma on Mars

Figure 4.30: Astronomical Calculations (AstroCalc): Two asteroids nearby to one place

Figure 4.31: Astronomical Calculations (AstroCalc): Risings, transits, and settings of
selected celestial object
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Figure 4.32: Astronomical Calculations (AstroCalc): Phenomena

Figure 4.33: Astronomical Calculations (AstroCalc): Graphs / Altitude vs. Time

Figure 4.34: Astronomical Calculations (AstroCalc): Graphs / Azimuth vs. Time
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The �Azimuth vs. Time� Subtab

On this subtab you can compute the geometrical azimuth of the currently selected object on the
currently set date and draw it as a graph (Fig. 4.34).

The �Monthly Elevation� Subtab

This subtab can show a �Monthly Elevation� graph for the current year at the selected time. This
tool was introduced for planning yearly observations (Fig. 4.35).

The �Graphs� Subtab

This subtab can show two functions over time for the current month or for up to 30 years and draw
graphs for them in one screen (Fig. 4.36). You can select from

� Magnitude vs. Time
� Phase vs. Time
� Distance vs. Time
� Elongation vs. Time
� Angular size vs. Time
� Phase angle vs. Time
� Heliocentric distance vs. Time
� Transit altitude vs. Time
� Right ascension vs. Time
� Declination vs. Time
This tool may be very helpful for educational and statistics purposes.5 For example, the

magnitude curve for Jupiter’s moons shows occasional dips where the moon is in Jupiter’s shadow.
However, while for most graphs a sampling interval of 24 hours should be suf�cient (i.e., 1 value per
day), for this graph you may want to reduce the sampling interval to 1 or 2 hours to avoid missing
those eclipses by undersampling. Of course, such high density takes much longer to compute, so
you should avoid plotting this curve for many years, or expect a long delay where the program may
seem unresponsive.

The �Lunar Elongation� Subtab

This subtab (Fig. 4.37) can show a �Lunar Elongation� graph � the angular distance between the
Moon and the selected object (for example some deep-sky object) for the nearest 30 days. This tool
was introduced for planning monthly observations.

4.6.6 The �What’s Up Tonight� (WUT) Tab

The �What’s Up Tonight� (WUT) tool6 displays a list of objects that will be visible at night for the
current date and location.

The objects are organized into type categories. Select an object type in the box labeled Select

a Category, and all objects of that type which are above the horizon on the selected night will be
displayed in the box labeled Matching Objects. For example, in the screenshot, the Planets category
has been selected, and three planets which are up in the selected night are displayed (Jupiter, Mars
and Mercury).

By default, the WUT will display objects which are above the horizon between sunset and
midnight (i.e. in the evening). You can choose to show objects which are up between midnight and
dawn (in the morning), around midnight, or any time between dusk and dawn (any time tonight)
using the combobox near the top of the window. You can also choose to see only those objects
that are brighter than a certain magnitude by setting a minimum magnitude using the Show objects

5The idea for this tool has been obtained from SkytechX: http://www.skytechx.eu/
6This tool has been partially ported from the KStars planetarium: https://edu.kde.org/kstars/

http://www.skytechx.eu/
https://edu.kde.org/kstars/
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Figure 4.35: Astronomical Calculations (AstroCalc): Graphs / Monthly Elevation

Figure 4.36: Astronomical Calculations (AstroCalc): Graphs

Figure 4.37: Astronomical Calculations (AstroCalc): Graphs / Lunar Elongation



4.6 The Astronomical Calculations Window 49

Figure 4.38: Astronomical Calculations (AstroCalc): What’s Up Tonight (WUT)

Figure 4.39: Astronomical Calculations (AstroCalc): Planetary Calculator (PC), Data Tab

Figure 4.40: Astronomical Calculations (AstroCalc): Planetary Calculator (PC), Graphs
Tab
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brighter than magnitude spinbox. You may center an object from the right list in the sky map just
by selecting it.

Note that only DSO from catalogs which you have selected in the DSO panel (section 4.4.3)
will be found.

In version 0.18.3 this tool has been refactored: the tool for searching items from list of
Matching Objects was removed, the �lter for magnitudes was moved to the right, and we added
a new �lter here to limit the range of acceptable angular sizes of matched objects. In addition to
the names we added 5 new sortable columns: magnitude, rising time, transit time, setting time and
angular size of object.

4.6.7 The �Planetary Calculator� (PC) Tab

The �Planetary Calculator� (PC) tool has been added after user requests. It computes the relations
between two Solar system bodies for the current date and location � linear and angular distances,
orbital resonances and orbital velocities.

The Graphs tab (Fig. 4.40) shows the change in the linear and angular distances between
selected celestial bodies over a range of 600 days (centered on the current date) as graphs.

4.6.8 The Eclipses Tab

The Eclipses tool has four subtabs: �All Solar Eclipses�, �Local Solar Eclipses�, �Lunar Eclipses�
and �Planetary Transits�.

You can export the calculated eclipses and transits into an XLSX or CSV �le.

Caution

Predicting eclipses and transits, and in particular local circumstances, over thousands of years in
the past and future is not reliable due to the principal unpredictability of DT , caused by �uctuations
of Earth’s rotation. (See section 18.4.3 for details.)

The �All Solar Eclipses� Subtab

Figure 4.41: Astronomical Calculations (AstroCalc): Eclipses / All Solar Eclipses

This subtab (Fig. 4.41) contains data for all solar eclipses on the Earth in the selected time range.
Double click on a line in the table will set location and time of greatest eclipse. Click on the table
row will show circumstances of selected eclipse in the lower table.
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The quantity Gamma is the minimum distance of the lunar shadow cone axis to the center of
the Earth, in units of Earth’s equatorial radius. This distance is positive or negative, depending on
whether the axis of the shadow cone passes north or south of the Earth’s center.

Click the Export KML. . . button to create a KML �le of the selected eclipse. KML is a �le
format used to display geographic data in Earth browsers, such as Marble, Google Earth or
Google Maps. The �le can be opened in applications that support KML version 2.2. A description
of the lines for solar eclipses is shown in Fig. 4.42. Different colors are used to draw path of
central eclipse. Red = total eclipse, blue = annular eclipse, and purple = hybrid eclipse. Limits of
penumbral or partial eclipse are green.

Northern limit of penumbra (partial eclipse)

Total Solar Eclipse 2027 August 2

Southern limit of penumbra (partial eclipse)

Outline of umbra
plotted every 10 minutes

Point of greatest eclipse

Path of total eclipse

Southern limit

Northern limit

Center line

Eclipse begins at sunrise

Maximum eclipse at sunrise
Eclipse ends at sunrise

Eclipse begins at sunset
Maximum eclipse at sunset
Eclipse ends at sunset

Figure 4.42: Key to solar eclipse map

The �Local Solar Eclipses� Subtab

This subtab (Fig. 4.43) contains data for solar eclipses for the current location (on the Earth!) in
de�ned time range.

Double click on a line in the table will set the time of greatest eclipse.

The �Lunar Eclipses� Subtab

This subtab (Fig. 4.44) contains data for all lunar eclipses on the Earth in de�ned time range.
Double click on the table row will set time of greatest eclipse. Click on the table row will show
circumstances of selected eclipse in the lower table.

The quantity gamma is the minimum distance from the center of the Moon to the axis of Earth’s
umbral shadow cone, in units of Earth’s equatorial radius. This distance is positive or negative,
depending on whether the Moon passes north or south of the shadow cone axis.

The visibility conditions are based on the altitude of the Moon at greatest eclipse:
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Figure 4.43: Astronomical Calculations (AstroCalc): Eclipses / Local Solar Eclipses

Figure 4.44: Astronomical Calculations (AstroCalc): Eclipses / Lunar Eclipses
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Invisible � the greatest eclipse is invisible at the current location (altitude is negative);
Not obs. � not observable eclipse. Our rule of thumb is that a partial penumbral eclipse is

detectable with the unaided eye if penumbral magnitude > 0.7;
Bad � bad visibility conditions for current location (altitude range is 0�30�);
Good � good visibility conditions for current location (altitude range is 30�45�; i.e., �photometric

altitude�);
Perfect � perfect visibility conditions for current location (altitude range is 45�90�).

The �Planetary Transits� Subtab

This subtab (Fig. 4.45) contains data for all transits of Mercury and Venus across the Sun as seen
from Earth (see 19.11.3) in the de�ned time range. If an event is not observable because the
Sun/planet is below the horizon, its time will be shown in brackets and greyed-out. Further columns
show the total duration of the event, and the observable duration at the current location, which takes
rising and setting times into account.

Double click on the table row will set time of mid-transit.

Figure 4.45: Astronomical Calculations (AstroCalc): Eclipses / Planetary Transits

4.6.9 The Almanac Tab

The Almanac tool has one subtab: �Speci�c Time�. v 25.1

The �Speci�c Time� Subtab

This subtab (Fig. 4.46) contains data for speci�c time moments in this year (starring and duration
seasons) and at today � time for setting and rising the Sun and Moon, time and duration of
twilights, and duration of the daytime and astronomical night. You can use buttons to quick set
these speci�c time moments. All dates and times are selectable.
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Figure 4.46: Astronomical Calculations (AstroCalc): Almanac / Speci�c Time
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4.7 The Help Window

4.7.1 The Help Tab

Figure 4.47: Help Window

The Help Tab lists all of Stellarium’s keystrokes. Note that some features are only available as
keystrokes, so it’s a good idea to have a browse of the information in this window.

4.7.2 The About Tab

The About Tab (Fig. 4.48) shows version and licensing information, and a list of people who helped
to produce the program. This tab also provides a tool to check for updates of Stellarium.

4.7.3 The Log Tab

The Log Tab (Fig. 4.49) shows messages like the loading con�rmations carried out when Stellarium
runs. It is useful to locate the �les that Stellarium writes to your computer. The same information is
written to the �le log.txt that you will �nd in your user data directory (see 5.1).

4.7.4 The Con�g Tab

The Con�g Tab (Fig. 4.50) shows con�guration data of the Stellarium. It is useful to locate the �les
that Stellarium writes to your computer. The same information is written to the �le config.ini

that you will �nd in your user data directory (see 5.1).
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Figure 4.48: Help Window: About

Figure 4.49: Help Window: Log�le

Figure 4.50: Help Window: Con�g �le
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4.8 Editing Keyboard Shortcuts

Figure 4.51: Keyboard Shortcuts

You can edit the shortcut keys here. Each available function can be con�gured with up to
two key combinations. You may want to recon�gure keys for example if you have a non-English
keyboard layout and some keys either do not work at all, or feel unintuitive for you, or if you are
familiar with other software and want to use the same hotkeys for similar functions. Simply select
the function and click with the mouse into the edit �eld, then press your key of choice. If the key
has been taken already, a message will tell you.

This tool is available through the Help Tab of the Help window (see section 4.7.1) and the
Tools Tab of the Con�guration window (see section 4.3.5).

4.8.1 Example

If you want to follow the sky view each evening with the Sun at the same depth below the horizon,
so that the twilight is of equal darkness, you may want to assign some actions to intuitive shortcut
keys. In the Keyboard Shortcut editor (Fig. 4.51), �nd theDate and Timegroup and assign, e.g.,
the keys on your numeric keypad:

Previous evening twilight Ctrl+9
Previous morning twilight Ctrl+7
Next evening twilight Ctrl+3
Next morning twilight Ctrl+1
Today's evening twilight Ctrl+6
Today's morning twilight Ctrl+4




























































































































































































































































































































































































































































































